PSoc® Creator™ Release Notes
Version 3.2 Service Pack 1

PSoc Creator 3.2 Service Pack 1 (SP1) is an upgrade from the PSoC Creator 3.2 release. This service pack updates several components, as well as associated example projects.

This release is cumulative of all PSoC Creator version 3.2 releases. If you already have a version of PSoC Creator 3.2 installed, then your version will be updated to the SP1 release. If you do not already have version 3.2, then the complete PSoC Creator 3.2 SP1 release will be installed.

PSoc Creator 3.2 is an upgrade from the PSoC Creator 3.1 release. It adds the following features:

- Support for PSoC 4x00 M-Series devices
- New PSoC 4 Design Templates
- New Design-Wide components
- Updated and extended support for third-party tools
- New support for bit-field manipulation of PSoC registers

This release does not replace existing installations of PSoC Creator (e.g., 3.0 or 3.1); it installs alongside them. This enables you to move designs to the new version at your own pace. We guarantee that your existing designs can be opened in the new software, but please upgrade your components to the latest version. To ensure that you can always return to your previous setup, a backup of your project is automatically created when opening a project in a new version of the tool. It is stored in a folder named "backup" in the project's folder.

If you have technical questions, visit www.cypress.com/go/support or call 1-800-541-4736 and select 8.

Contents

PSoc Creator 3.2 Service Pack 1 Contents .................................................................................................................. 3
  Updated Components .................................................................................................................................................... 3
  Updated Example Projects ............................................................................................................................................ 3

PSoc Creator 3.2 Features ............................................................................................................................................. 4
  Support for PSoC 4x00 M-Series Devices ................................................................................................................ 4
  New PSoC 4 Project Templates .................................................................................................................................. 4
  New Design-Wide Components ............................................................................................................................... 4
  Updated and Extended Support for Third-Party Tools ............................................................................................. 4
  New Support for Bit-Field Manipulation of PSoC Registers ...................................................................................... 5
  New Components ...................................................................................................................................................... 5
  Updated Components ............................................................................................................................................... 5

Design Impact .............................................................................................................................................................. 6
  Minor Automated Component State Feature Issue .................................................................................................... 6
  GCC Link Time Optimization (LTO) Feature Removed ............................................................................................... 6
  Previously Successful Designs Fail Digital Placement in PSoC Creator 3.2 .......................................................... 6
  Pre-Production BLE Flashloaders ............................................................................................................................ 6
  PSoC 4 Comparator Component with DeepSleep Fails on PSoC 4x00 M-Series Devices ....................................... 6
  PSoC 4 cy_boot/CyLFClk Migration ....................................................................................................................... 6
  Improved Debug Optimization .................................................................................................................................. 7

August 3, 2015
Windows XP SP2 No Longer Supported
Issue with Export to Eclipse IDE Feature
Removing Older Components

Supported Devices
Supported Tool Chains
Toolchains for PSoC 3 (8051)
Toolchains for PSoC 4 and PSoC 5LP (ARM)

Installation
Minimum and Recommended System Requirements
Software Update Instructions
Open Source
Installation Notes

Further Reading
Defect Fixed
PSOC Creator 3.2 Service Pack 1 Contents

This service pack updates the following components. Also included are updated associated example projects and design templates that use those components.

Updated Components

The following components have been updated in this release. Refer to the component datasheet for specific details about what was changed.

- ADC_SAR_SEQ_P4 2.20
- cy_boot 5.10
- Trim Margin 2.0
- BLE 2.10
- LPComp_P4 2.10
- Voltage Fault Detector 3.0

Updated Example Projects

As a result of the updated components and defect fixes, the following example projects have been updated in this release:

- ADC_Differential_Preamplifier
- BLE_AlertNotification
- BLE_Blood_Pressure_Sensor
- BLE_Cycling_Sensor
- BLE_Environmental_Sensing
- BLE_External_Memory_Bootloader
- BLE_Glucose_Meter
- BLE_HR_Sensor
- BLE_HID_Mouse
- BLE_Proximity
- BLE_Shared_Memory_Bootloader
- BLE_TimeSync
- CapSense_CSD_P4_Trackpad_Gestures
- DebouncerExample
- Fan_Control_Auto_FW_with_Alert
- GlitchFilter
- HW_Fan_Control_with_Alert
- Opamp_Dynamic_Gain_Switching
- ScanCompCommonExample
- VFD_Example
- ADC_SAR_Seq_DieTemp_PsoC4
- BLE_Battery_Level
- BLE_Continuous_Glucose_Monitoring_Sensor
- BLE_Device_Information_Service
- BLE_External_Memory_Bootloadable
- BLE_FindMe
- BLE_Heart_Rate_Collector
- BLE_HID_Keyboard
- BLE_Phone_Alert
- BLE_Running_Speed_Cadence
- BLE_Temperature_Measurement
- CAN_Basic_P4_Example
- ComparatorExample
- DMA_ADC_PSoC4
- FW_Fan_Control_example
- Hibernate_and_Stop_PowerMode
- LPOperator_PSoC4_Example
- PMBusThermExample
- TrimMarginExample
- VoltSeqExample
PSoc Creator 3.2 Features

Support for PSoc 4x00 M-Series Devices

PSoc Creator has been updated to support PSoc 4x00 M-Series devices. These devices extend the PSoc 4 portfolio with a 48 MHz industry standard ARM Cortex-M0 MCU, up to 128KB Flash, 55 I/O, DMA and CAN. These devices are also referred to as PSoc 4100M and PSoc 4200M.

New PSoc 4 Project Templates

To save time when creating new projects, PSoc Creator now includes schematic templates that populate the schematic file with all the typical functionality for your selected device. You no longer need to add the I2C, ADC, and CapSense to every project you create. The design is split into multiple tabs – Communication, Digital, ADC, etc. – so there is plenty of space for you to add, modify or delete the template content to suit your needs.

This release includes templates for PSoc 4 BLE (Bluetooth Low Energy), PSoc 4x00 M-Series, PSoc 4000, PSoc 4100, and PSoc 4200 devices.

Note If you prefer to start from a blank sheet, you can still do that (except for PSoC BLE) by selecting "Empty Schematic" for the Project template option on the New Project dialog.

New Design-Wide Components

Some of the new silicon features of PSoc 4x00 M-Series devices require that PSoc Creator generate new design-wide APIs. Examples of this are RTC_P4/CY_LFCLK and DMA_P4. For these components, you do not place a component on the schematic, but instead, interface directly through APIs provided by the new design-wide components.

Also, as part of this change, the System Reference Guide (datasheet for the cy_boot component) has been divided into two documents: one for PSoc 4 devices and another for PSoc 3/PSoc 5LP devices. The new design-wide component datasheets are also considered System Reference Guides, and all of the documents are accessible from the PSoc Creator Help menu.

Updated and Extended Support for Third-Party Tools

Support for the third-party tools for which PSoc Creator designs can be exported has been updated and extended to provide additional features, including:

- Eclipse Luna
- IAR Embedded Workbench v7
- µVision 5, using the CMSIS-PACK standard (Beta)
**New Support for Bit-Field Manipulation of PSoC Registers**

There is a new API that enables bit-field access to registers in all PSoC 4-based devices. This API can be used by firmware developers to develop applications (or libraries) that interface directly to the hardware outside of the usual component APIs.

**New Components**

The following new components have been added as part of this release:

- CSD_ADC 1.0 – This component uses the CapSense CSD hardware to perform voltage measurements.
- CY_LFCLK (PSoC 4) 1.0 – This component provides the application interface to configure various low-frequency clocks available in PSoC 4.
- DMA_P4 1.0 – This PSoC 4 component transfers data to and from memory, components, and registers.
- RTC_P4 1.0 – This PSoC 4 component provides an application interface for keeping track of time and date.

**Updated Components**

The following components have been updated to new versions as part of this release to address various component defects and feature updates. Refer to the component datasheet for specific details.

- BLE 2.0
- CAN 3.0
- CapSense CSD/Gesture (PSoC 4) 2.20
- cy_boot 5.0
- IDAC_P4 1.10
- LIN 3.20
- SCB_P4 3.0
- SegLCD_P4 1.20
- SMBusSlave 5.0
- SW Tx UART 1.40
Design Impact

**Minor Automated Component State Feature Issue**

A new feature to display a component's state automatically has the very small potential to display text twice. This only involves older imported components or user-made components that use the old method of displaying the component state. This is a benign error in that the design will still build (prototype) or not build (obsolete), just as before. It is a visual defect only.

**GCC Link Time Optimization (LTO) Feature Removed**

Due to known defects in the GNU-ARM compiler, the LTO feature was removed from the PSoC Creator 3.2 Build Settings dialog. If you use this feature in your design, refer to Knowledge Base Article KBA97708.

**Previously Successful Designs Fail Digital Placement in PSoC Creator 3.2**

A defect was fixed in PSoC Creator 3.2 to prevent UDB components with mixed clock enable modes from being placed in the same UDB resource. This fix changed the UDB packing solution and can cause some valid designs to no longer succeed when built in PSoC Creator 3.2. You can work around this by generating a control file using the placements from your previous version of PSoC Creator. To do this, open your design in the previous version of PSoC Creator and add a control file using the steps documented in the Control File help topic. Then use the syntax of the file to force your UDB-based components to have a fixed placement. This solution assumes that you do not update to new component versions when migrating to PSoC Creator 3.2.

**Pre-Production BLE Flashloaders**

The PRoC BLE and PSoC 4100 BLE/PSoC 4200 BLE devices introduced in PSoC Creator 3.2 do not have 3rd party flashloaders available. The flashloaders will be made available in Q3 2015. Until then, the export to the 3rd party (µVision, IAR, and, Eclipse) tools process is not fully supported.

**PSoC 4 Comparator Component with DeepSleep Fails on PSoC 4x00 M-Series Devices**

A pin connected to the inverting input of a PSoC 4 Comparator (Comp_P4) component may fail to route when the comparator is configured for DeepSleep operation. To work around this issue, lock the inverting input pin to a location for an opamp other than OA3. This will be fixed in PSoC Creator version 3.3.

**PSoC 4 cy_boot/CyLFClk Migration**

The cy_boot component version 5.0 is fully backward compatible with cy_boot version 4.20 (and previous versions). For PSoC 4 devices, the CY_LFCLK (low-frequency clock) APIs have been moved into separate files (CyLFClk.h/CyLFClk.c).

Firmware projects created using PSoC Creator 3.1 will work with no issues in PSoC Creator 3.2 if the project.h file is referenced, regardless of the cy_boot update. However, if the project.h file is not included in the project being migrated, you must add a reference to the CyLFClk.h file in the project for the availability of CyLFClk APIs. If you choose not to update to cy_boot version 5.0 while migrating projects from PSoC Creator 3.1 to PSoC Creator 3.2, CyLFClk.h/CyLFClk.c files will not be generated.
**Improved Debug Optimization**

PSoc Creator 3.2 improves the optimization level of code, even in the Debug configuration using the GCC toolchain. This optimization leads to a ~30% improvement in code density, allowing you to fit more in your design before moving to the Release configuration. This does have impact on the user debugging experience when user code can be aggressively optimized by the compiler. If the improved optimization is impacting your debugging experience, you can remove the optimization in the Build Settings dialog. Select the project and then select **Build Settings** from the **Project** menu. On the dialog, select **Compiler > Optimization > Optimization Level setting**.

![Build Settings Dialog](image)

**Windows XP SP2 No Longer Supported**

Microsoft ceased supporting Windows XP SP2 in July 2010. There is a defect in that version of Windows that can impact PSoc Creator. The defect is fixed in Windows XP SP3. So, as of PSoc Creator 3.2 and all future releases, Windows XP SP2 is no longer supported.
**Issue with Export to Eclipse IDE Feature**

When exporting a project to the Eclipse IDE, during the "C Project" step in Eclipse, an error may indicate that the project location is incorrect.

![Eclipse C Project error message](image)

This is due to having the incorrect PSoC Creator Import feature. For PSoC Creator 3.2 (and PSoC Creator 3.1), the version required is v2.0.5 or later.

To check which version you have, select the Eclipse **Help** menu > **About Eclipse**. In the dialog, click the **Installation Details** button. Then look on the **Installed Software** tab for the PSoC Creator Import Feature entry and check its Version value.

![Eclipse Installation Details](image)

You can download the Creator Import feature for Eclipse from:
http://www.cypress.com/go/creator/eclipseimportdownload
Removing Older Components

A number of old versions of components were re-classified as obsolete for all devices in this release. These components are not shipped with the PSoC Creator 3.2 software. In all cases there are newer versions of the component that are of a higher quality. You should update your designs to use these newer components.

Using the obsolete components in PSoC Creator 3.2 will cause a design-rule error to be output to the Notice List window. This message requests that you update the component version or take alternative actions to get onto supported implementations. The following are the affected components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Removed Versions</th>
<th>Current Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC_DelSig</td>
<td>2.20</td>
<td>3.20</td>
</tr>
<tr>
<td>ADC_SAR</td>
<td>1.60, 1.70, 1.71</td>
<td>3.00</td>
</tr>
<tr>
<td>Amux</td>
<td>1.50</td>
<td>1.80</td>
</tr>
<tr>
<td>AMuxSeq</td>
<td>1.50</td>
<td>1.80</td>
</tr>
<tr>
<td>BoostConv</td>
<td>2.0</td>
<td>5.0</td>
</tr>
<tr>
<td>CAN</td>
<td>2.0, 2.1</td>
<td>3.0</td>
</tr>
<tr>
<td>CapSense_CSD</td>
<td>3.0, 3.10</td>
<td>3.50</td>
</tr>
<tr>
<td>CharLCD</td>
<td>1.50</td>
<td>2.10</td>
</tr>
<tr>
<td>Comp</td>
<td>1.60, 1.70, 1.80</td>
<td>2.0</td>
</tr>
<tr>
<td>Counter</td>
<td>2.0, 2.10</td>
<td>3.0</td>
</tr>
<tr>
<td>CRC</td>
<td>2.10</td>
<td>2.40</td>
</tr>
<tr>
<td>cy_boot</td>
<td>2.40</td>
<td>5.0</td>
</tr>
<tr>
<td>cy_clock</td>
<td>1.50, 1.60</td>
<td>2.20</td>
</tr>
<tr>
<td>cy_dma (PSoC 3 / PSoC 5LP)</td>
<td>1.50</td>
<td>1.70</td>
</tr>
<tr>
<td>cy_gsref</td>
<td>1.0</td>
<td>2.0</td>
</tr>
<tr>
<td>cy_isr</td>
<td>1.50</td>
<td>1.70</td>
</tr>
<tr>
<td>cy_pins</td>
<td>1.50, 1.60</td>
<td>2.10</td>
</tr>
<tr>
<td>cy_vref</td>
<td>1.50</td>
<td>1.60</td>
</tr>
<tr>
<td>CyControlReg</td>
<td>1.60</td>
<td>1.80</td>
</tr>
<tr>
<td>CyStatusReg</td>
<td>1.60</td>
<td>1.90</td>
</tr>
<tr>
<td>demux</td>
<td>1.0</td>
<td>1.10</td>
</tr>
<tr>
<td>DFB</td>
<td>1.0</td>
<td>1.40</td>
</tr>
<tr>
<td>DieTemp (PSoC 3 / PSoC 5LP)</td>
<td>1.60, 1.70</td>
<td>2.0</td>
</tr>
<tr>
<td>EEPROM</td>
<td>1.60</td>
<td>3.0</td>
</tr>
<tr>
<td>emFile</td>
<td>1.0</td>
<td>1.20</td>
</tr>
<tr>
<td>EMIF</td>
<td>1.0</td>
<td>1.30</td>
</tr>
<tr>
<td>EZI2C</td>
<td>1.60, 1.61</td>
<td>2.0</td>
</tr>
<tr>
<td>Fan Controller</td>
<td>2.0</td>
<td>4.0</td>
</tr>
<tr>
<td>Filter</td>
<td>2.0</td>
<td>2.30</td>
</tr>
<tr>
<td>GraphicLCDCtrl</td>
<td>1.61</td>
<td>1.70</td>
</tr>
<tr>
<td>Component</td>
<td>Removed Versions</td>
<td>Current Version</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>GraphicLCDIntf</td>
<td>1.61</td>
<td>1.70</td>
</tr>
<tr>
<td>I2C</td>
<td>2.0, 2.10, 2.20, 3.0, 3.1</td>
<td>3.50</td>
</tr>
<tr>
<td>I2S</td>
<td>2.20</td>
<td>2.60</td>
</tr>
<tr>
<td>IDAC8</td>
<td>1.70, 1.80</td>
<td>2.0</td>
</tr>
<tr>
<td>LIN</td>
<td>1.0</td>
<td>3.20</td>
</tr>
<tr>
<td>Mixer</td>
<td>1.70, 1.80</td>
<td>2.0</td>
</tr>
<tr>
<td>mux</td>
<td>1.0</td>
<td>1.10</td>
</tr>
<tr>
<td>OpAmp</td>
<td>1.70</td>
<td>1.90</td>
</tr>
<tr>
<td>PGA</td>
<td>1.70</td>
<td>2.0</td>
</tr>
<tr>
<td>PGA_Inv</td>
<td>1.70</td>
<td>2.0</td>
</tr>
<tr>
<td>PowerMonitor</td>
<td>1.0</td>
<td>1.60</td>
</tr>
<tr>
<td>PWM</td>
<td>2.0, 2.10</td>
<td>3.30</td>
</tr>
<tr>
<td>QuadDec</td>
<td>2.0</td>
<td>3.0</td>
</tr>
<tr>
<td>ResistiveTouch</td>
<td>1.0</td>
<td>2.0</td>
</tr>
<tr>
<td>RTC</td>
<td>1.60</td>
<td>2.0</td>
</tr>
<tr>
<td>Sample_Hold</td>
<td>1.0, 1.10</td>
<td>1.40</td>
</tr>
<tr>
<td>SegLCD</td>
<td>2.10, 3.0</td>
<td>3.40</td>
</tr>
<tr>
<td>ShiftReg</td>
<td>1.60, 2.0</td>
<td>2.30</td>
</tr>
<tr>
<td>SleepTimer</td>
<td>2.0, 2.1</td>
<td>3.20</td>
</tr>
<tr>
<td>SPDIF_Tx</td>
<td>1.0</td>
<td>1.20</td>
</tr>
<tr>
<td>SPI_Master</td>
<td>2.20, 2.21</td>
<td>2.50</td>
</tr>
<tr>
<td>SPI_Slave</td>
<td>2.20</td>
<td>2.70</td>
</tr>
<tr>
<td>StaticSegLCD</td>
<td>2.0</td>
<td>2.30</td>
</tr>
<tr>
<td>TIA</td>
<td>1.70, 1.80</td>
<td>2.0</td>
</tr>
<tr>
<td>Timer</td>
<td>2.10, 2.20</td>
<td>2.70</td>
</tr>
<tr>
<td>UART</td>
<td>2.0, 2.10</td>
<td>2.50</td>
</tr>
<tr>
<td>USBFS</td>
<td>2.10, 2.11, 2.12</td>
<td>2.80</td>
</tr>
<tr>
<td>VDAC8</td>
<td>1.70</td>
<td>1.90</td>
</tr>
</tbody>
</table>
Supported Devices

The design flow and tools available in PSoC Creator support the following PSoC 3 (CY8C3x), PSoC 4xxx (CY8C4x), PSoC 5LP (CY8C5x-LP), and PRoC BLE (CYBL10*).

<table>
<thead>
<tr>
<th>Part Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSoC 3</td>
</tr>
<tr>
<td>PSoC 4000</td>
</tr>
<tr>
<td>PSoC 4100 / PSoC 4200</td>
</tr>
<tr>
<td>PSoC 4100 BLE / PSoC 4200 BLE</td>
</tr>
<tr>
<td>PSoC 4100M / PSoC 4200M</td>
</tr>
<tr>
<td>PSoC 5LP</td>
</tr>
<tr>
<td>PRoC BLE</td>
</tr>
</tbody>
</table>

Supported Tool Chains

**Toolchains for PSoC 3 (8051)**

**DP8051 Keil™ 9.51a**

The Keil PK51 Professional Developers Kit for PSoC is installed with PSoC Creator. It supports optimization levels 0 through 5. If you would like to use the compiler optimization levels above level 5, you should purchase the standard PK51 product by contacting Keil.

- In North, Central, or South America... sales.us@keil.com
- In Europe, Asia, Africa, or Australia... sales.intl@keil.com

The free Keil toolchain comes with a 30 day evaluation license. You can extend the license, without cost, by registering the product from within PSoC Creator (Help > Register > Keil...). Note that the extended license is for one year and that you will need to re-register it each year.

**DP8051 Keil Generic**

This option can be used to select a separately-installed version of the Keil toolchain. While any version can be selected, the only officially supported versions are 8.16, 9.03, and 9.51a.

**Toolchains for PSoC 4 and PSoC 5LP (ARM)**

- **ARM GCC 4.8.4** – The GCC ARM Embedded v4.8.4 toolchain is installed with PSoC Creator. This toolchain has no use restrictions and does not require license activation (it is distributed under the terms of the GNU Public License).
- **ARM GCC Generic** – This option can be used to select a separately-installed version of the ARM GCC toolchain.
- **ARM MDK Generic** – This option can be used to select a separately-installed version of the ARM Microcontroller Development Kit. The officially supported version is 4.72a.

**Note** Support for RVDS has been discontinued as of this release.
Installation

Minimum and Recommended System Requirements

The following are system requirements to install and use PSoC Creator. Each requirement specifies a minimum that your system must meet or exceed.

PSoC Creator will execute correctly in highly resource-constrained systems. However, performance (startup time, project creation and opening, build times, and so on) may be impacted when resources are scarce. The most directly impacted performance metric is build time. The following sections provide examples of the resource scarcity impact.

Note During initial startup, PSoC Creator builds and caches component DLL files used to display the component parameter editors. As a result, the tool will launch less quickly the first time after a new installation or a Windows® reboot.

Summary

<table>
<thead>
<tr>
<th>Hardware/Operation System Requirements</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz or faster 32-bit (x86) or Intel 64/</td>
</tr>
<tr>
<td>RAM</td>
<td>AMD64 64-bit</td>
</tr>
<tr>
<td>Free Hard Drive Space</td>
<td>512 MB (1 GB preferred)</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>5 GB</td>
</tr>
<tr>
<td>USB</td>
<td>1024x768</td>
</tr>
<tr>
<td></td>
<td>2.0</td>
</tr>
</tbody>
</table>

Software Prerequisites *                          | Minimum Version                             |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer (not IE8 beta)</td>
<td>7</td>
</tr>
<tr>
<td>.NET Framework (PSoC Creator)</td>
<td>2.0 SP2</td>
</tr>
<tr>
<td>.NET Framework (Cypress Document Manager)</td>
<td>4.0</td>
</tr>
<tr>
<td>Adobe Reader (for viewing PDF Documentation)</td>
<td>9.2 **</td>
</tr>
<tr>
<td>Windows Installer</td>
<td>3.1</td>
</tr>
<tr>
<td>PSoC Programmer</td>
<td>3.23.1</td>
</tr>
<tr>
<td>Keil Compiler</td>
<td>8.16 (9.51a provided)</td>
</tr>
</tbody>
</table>

* To install and run PSoC Creator, you may also need to install additional software. The Cypress Installer will guide you through the process if the additional programs are not already installed.

** For Windows 7, the minimum required version of Adobe Reader is version 9.2. You can download the latest version here: http://get.adobe.com/reader/. You can also use a non-Adobe PDF reader if you prefer; however, Cypress has no recommendations for any particular non-Adobe reader or version.

Processor

1 GHz or faster 32-bit (x86) or Intel 64/AMD64 64-bit processor is required.

PSoC Creator exhibits a predictable relationship between CPU speed and build time above 1 GHz. Doubling the CPU speed, e.g., from 1 GHz to 2 GHz or 1.5 GHz to 3 GHz, almost halves the build time.

On a fast (3 GHz) PC, simple designs can build in about one minute. At low speeds even designs that fill the device and generate complex routing solutions will build in under 5 minutes.
Operating System

One of the following Windows platforms is required:

- Windows XP SP3 (32-bit supported)
- Windows Vista SP2 (32- and 64-bit supported)
- Windows 7 and Windows 7 SP1 (32- and 64-bit supported)
- Windows 8 and Windows 8.1 (32- and 64-bit supported)
- Mac OS 10.9 on VMware Fusion 6 running Windows 7 SP1
- Mac OS 10.9 on Parallels Desktop 10 running Windows 8.1

Memory

A minimum of 512 MB of RAM is required, but 1 GB is recommended.

Note Cypress does extensive performance testing on every PSoC Creator release. The minimum RAM configuration used in these tests is 1 GB. No guarantees of system performance are given below 1 GB.

With no other applications running, the minimum system configuration will ensure that the tool launches quickly, creates and opens projects in a few seconds, and responds to user input without feeling sluggish.

System RAM has the most direct impact on PSoC Creator build times. The following chart shows how insufficient RAM (i.e., below 512 MB) causes an excessive increase in build time, even for "empty" designs.

![Graph showing build times for complex and simple designs with varying RAM sizes.](image)

The graph shows that performance is heavily degraded below the threshold where memory paging is required but extra memory above that level does not generate a significant improvement.

Free Disk Space

PSoC Creator requires 5 GB of free disk space. PSoC Creator will install and run with just 1 GB of free disk space. However, in order to allow Windows to do memory paging, we recommend a minimum free disk space requirement of 5 GB.

If your disk is highly fragmented it will severely impact memory paging time and can result in very long build times. Disks that are nearly full are particularly prone to fragmentation. We recommend defragmenting your disk if you experience excessively long build times (10 minutes or more).
USB

PSoc Creator requires a USB 2.0-compliant host to program and debug.

Screen

A resolution of 1024x768 pixels or higher is required.

Note The build time examples given above were obtained with new product installations on minimally fragmented disks with no other applications running. If your build times exceed these expectations we recommend closing unnecessary applications, adding RAM to the system (to reduce paging) and ensuring that there is sufficient free and unfragmented disk space.

Software Update Instructions

As part of the installation process, the Cypress Update Manager utility will also be installed and located on the Start menu. You can use this utility to update all Cypress programs you have installed when updates for them become available.

Open Source

Portions of this software package are licensed under free and/or open source licenses such as the GNU General Public License. Such free and/or open source software is subject to the applicable license agreement and not the Cypress license agreement covering this software package. The applicable license terms will accompany each source code package. You may obtain the source code of such free and/or open source software at no charge from the following web site: www.cypress.com/go/opensource.

Installation Notes

The installation process is a set of wizards that walk you through installing various components. You can install PSoC Creator and various prerequisites from the web or from a DVD. There are slight differences in the process based on the medium used to install the software.

The DVDs provide the necessary prerequisites and the wizards to guide you through installing the appropriate software. The following sections contain more specific installation details.

Note Do NOT plug in your Miniprog3 until all software installation is complete AND the PSoC Creator application has been opened.

PSoC Creator DVD Installation

The PSoC Creator DVD contains PSoC Creator and PSoC Programmer, as well as various prerequisites.

1. Load the DVD. The main installer program should run automatically. If not, double-click the cyautorun.exe file to launch it.
2. On the main installer, click the Install PSoC Creator <version> button to launch the PSoC Creator InstallShield Wizard.
3. Follow the prompts on the wizard. The CyInstaller for PSoC Creator opens and displays steps to install PSoC Creator.
4. Click the hyperlink for any software that is not installed as indicated (such as, Acrobat Reader, etc.). Run the installer for that program as needed.
5. Continue following the prompts to install PSoC Creator.
Cypress PSoC Kit DVD Installation

A kit DVD contains PSoC Creator and PSoC Programmer, as well as projects, documentation, and prerequisites needed for the associated kit. Refer to kit instructions.

Web Installation

If you are downloading the software from the web (www.cypress.com/creator), run the PSoC Creator single package executable.

1. Double-click the PSoC Creator executable file to launch the installer.
2. If a non-Cypress prerequisite is missing (like .Net and Windows Installer, etc), a webpage with a download link will pop up. Download and install the prerequisites. Run the installer of those programs as needed.
3. Follow the prompts to install PSoC Creator. The CyInstaller for PSoC Creator opens and displays a series of steps to install PSoC Creator, and it will perform prerequisite checks and install the prerequisites.
4. When complete, close the installer.

Further Reading

The primary documentation for PSoC Creator is provided in the Help, which you can open from the Help menu or by pressing [F1]. Other documents included with this release are also available from the Help menu, under Documentation. These documents include (but are not limited to):

- Quick Start Guide
- System Reference Guide
- Component Author Guide

Cypress provides a web page specifically for PSoC Creator at www.cypress.com/creator. You can also find more documentation using the Cypress Document Manager (CDM) tool, which is available for download from the Cypress web site at www.cypress.com/cypressdocumentmanager.

Other documentation includes (but is not limited to):

- Device Datasheets
- Device Registers TRM
- Migration Guides
- Application Notes
- Training

Contact your Cypress representative, as needed.
## Defect Fixed

The following defect was fixed in this release.

<table>
<thead>
<tr>
<th>Cypress ID</th>
<th>Defect</th>
<th>Fix and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>211016</td>
<td>After programming a PSoC 41xx BLE part, the device behaves unpredictably, up to and including locking the CPU.</td>
<td>Flash wait cycles for the PSoC 41xx BLE devices were set incorrectly. This has been corrected and now the devices will behave correctly.</td>
</tr>
</tbody>
</table>
PSoC® Creator™ Release Notes
Version 3.2 Service Pack 1

Cypress Semiconductor
198 Champion Ct.
San Jose, CA 95134-1709 USA
Tel: 408.943.2600
Fax: 408.943.4730
Application Support Hotline: 425.787.4814
www.cypress.com

© Cypress Semiconductor Corporation, 2015. All rights reserved.

The information contained herein is subject to change without notice. Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

PSoC® and CapSense® are registered trademarks, and Programmable System-on-Chip™, PSoC Creator™, and SmartSense™ are trademarks of Cypress Semiconductor Corporation. All other trademarks or registered trademarks referenced herein are property of the respective corporations.

This Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom software and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein. Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

Use may be limited by and subject to the applicable Cypress software license agreement.